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INTRODUCTION

Welcome to the eta/DYNAFORM version 5.6 Training Manual. The eta/DYNAFORM
version 5.6 is the unified version of the DYNAFORM-PC and UNIX platforms.  This manual
is meant to give the user a basic understanding of finite element modeling for forming analysis,
as well as displaying the forming results. It is by no means an exhaustive study of the simulation
techniques and capabilities of eta/DYNAFORM. For more detailed study of eta/DYNAFORM,
the user is urged to attend an eta/DYNAFORM training seminar.

This manual details a step-by-step sheet metal forming simulation process through traditional
finite element (FE) modeling and the newer QuickSetup interface process. Users should take the
time to learn both setup processes as each has inherent benefits and limitations.

The traditional setup procedure is extremely flexible and can be used to setup any forming
simulation. Because the QuickSetup makes certain assumptions as to the type of tooling
configuration selected it is not as flexible, however, it automates many of the procedures
required for traditional model setup such as travel curves.

The  following  table  outlines  the  major  differences  between  the  QuickSetup  and  the  traditional
setup procedure.

TRADITIONAL SETUP QUIK SETUP AUTO SETUP
Manual interface can duplicate
any tooling configuration: pads,
multiple tools, etc.

Automated interface limits
flexibility

There are some inner templates
that enables user to setup all kinds
of operation.

Requires more setup time Reduces modeling setup time Reduces setup time and reduces
the possibility of make mistake

Manual definition of travel curves Automated travel curves Automated travel curves and
manual definition curve

Geometrical Offset Contact Offset Both Contact Offset and
Geometrical Offset

Note: This manual is intended for the application of all eta/DYNAFORM platforms.  Platform
interfaces may vary slightly due to different operating system requirements. This may cause some
minor visual discrepancies in the interface screen shots and your version of eta/DYNAFORM
that should be ignored.
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DATABASE MANIPULATION

I. CREATING AN ETA/DYNAFORM DATABASE AND ANALYSIS SETUP

Start eta/DYNAFORM 5.6.

For workstation/Linux users, enter the command “df56” (default) from a UNIX shell.
For PC users, double click the eta/DYNAFORM 5.6 (DF56) icon from the desktop.

After starting eta/DYNAFORM, a default database Untitled.df is created. Users will begin by
importing CAD files to the current database.

Import files

1. From the menu bar, select FileºImport.

Change the file format to “LINE DATA (*.lin)”.  Go to the training input files located in the
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CD provided along with the eta/DYNAFORM installation. Locate two data files: die.lin and
blank.lin. Then, import both files and select OK to dismiss the Import File dialogue window.

After reading in all of the data files, verify the display looks the same as the illustration shown
above. The parts are displayed in the isometric view which is the default view setting of
eta/DYNAFORM.

Note: Icons may appear different depending on platform. Other functions on the Toolbar will
be discussed further in the next section. You can also refer to the eta/DYNAFORM
User’s Manual for information on all of the Toolbar functions.
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2. Save the database to the designated working directory.  Go to FileºSave as, type
“dftrain.df”, and select Save to dismiss the dialogue window.

Analysis Setup

The default unit system for a new eta/DYNAFORM database is mm, Newton, second, and Ton.
The default setting for draw type is double action (toggle draw).  The user is able to change
these default settings from the ToolsºAnalysis Setup menu.

Notice: Draw Type should accord with press type in practice. The parameters define the working
direction of default punch and die. If you are not sure or operating new technique, you should
select User Defined. You can also refer to the eta/DYNAFORM User’s Manual for information
on all of the Draw Type functions.

File Types

Eta/DYNAFORM has the ability to read the following types of input files:

1.    Abaqus (*.inp) 8.  VDA (*.vda,vdas)
2.    LS-DYNA (*.dyn, *.mod, *.k) 9.   DYNAIN file (dynain*, *.din)
3.    NASTRAN (*.nas, *.dat) 10. CATIA v4/v5 (*.model, *.CADPart)
4.     Stereo  lithograph   (*.stl) 11. ProE (*.prt, *.asm)
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5.    Autocad (*.dxf) 12. STEP (*.stp)
6.     Line  Data  (*.lin) 13. Unigraphics  (*.prt)
7.    Iges (*.igs, *.iges) 14. dynain file

II. PRACTICE SOME AUXILIARY MENU OPERATIONS

After successfully reading in the needed files to begin the finite element modeling, practice to get
familiar with some of the basic functions and menus.

View Manipulation

View Manipulation

The view manipulation area of the Toolbar is one of the most visited spots in eta/DYNAFORM.
These functions enable the user to change the orientation of the display area. Place the mouse
pointer over each icon to display the name and function of each icon. Also, take notice of the
Display Options area (shown below) at the bottom right hand side of the screen. This is another
area enabling the user to manipulate the display area.

The following steps will help you become more familiar with the functions found in the Toolbar,
and in the Display Option window.

1. Select Isometric from the Toolbar. This places the displayed geometry in an isometric
view, as shown earlier. The function is shown below:

2. Rotate the geometry dynamically about the z-axis approximately 90° by using the Rotate
about Z-Axis function. The function is shown below:

3. Select Right View (YZ Plane). The result is shown below:
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4. Select Free Rotation to rotate the model.

5. Select Fill Screen from the Toolbar, this makes the displayed geometry fill the screen.

6. Practice using the other viewing options before moving on.

III.TURNING PARTS ON/OFF

All geometry in eta/DYNAFORM is arranged based on parts. Every entity, by default, will be
created or read into a part. The user should practice using the On/Off function, located in the
Toolbar,

or in the Parts menu: PartsºTurn On.
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1. Notice the Turn On/Off Part dialogue that appears after selecting the Part On/Off button.

Place the cursor over different icons and buttons to learn the name of each function. This
type of selection menu is common in the eta/DYNAFORM environment. It provides several
different functions for selecting which parts will be turned off or on.

2. Since the part BLANK.LIN contains only line data, you will have to use either the Select by
Line or the Select by Name function.

3. First, use the Select by Line icon to turn off the part, BLANK.LIN. Click the Select by Line
icon, and select a line in the part, BLANK.LIN. The part will be turned off.

4. Next, use the Select by Name function, and select BLANK.LIN from the list in the window.
In the Select by Name window, the parts that are turned on are displayed in their color and
the parts that are turned off are displayed in white.
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5. Before we continue, verify that all available parts are turned on. Select the All  On button
from the Turn On/Off Part dialogue.

6. After you have turned all the parts on, click the OK button on the Turn On/Off Part
dialogue. This will end the current operation

IV. EDITING PARTS IN THE DATABASE

The Edit Part command is used to edit part properties and delete parts.

1. From the above menu, click the Edit button.

The Edit Part dialogue will be displayed, with a list of all the parts that are defined in the
database. The parts are listed with the part name and identification number. From here, you
can modify the part name, ID number and part color. You can also delete parts from the
database.
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2. Select the part DIE.S from the part list. Change its color by clicking on the Color button and
selecting a new color from the palette.

3. Select the part DIE.S from the part list. Change the Name by inputting LOWTOOL in the
field as shown below.

4. Once you have entered the new name (LOWTOOL) and selected the desired part color,
click on the Modify button located at the bottom left of the dialogue to make the changes.

5. Click Close to end this operation.

6. Save your database.

Note: Designers often model only one surface of upper or lower die. The other die face will offset from
the mating surface. In this case, we suppose the surface is the lower tool. And the upper tool will
offset from the surface later. So we give the part name LOWTOOL.

V. CURRENT PART

All lines, surfaces, and elements which were created will automatically be placed into the current
part. When creating new lines, surfaces, or elements, always make sure the desired part is set as
current.

Note: When auto-meshing surfaces, the user does have the option of assigning the created mesh to the
parts that contain the individual surface data. In other words, you can keep the mesh in the
original parts, rather than have them all created in the current part. This will be dealt with later.

1. To change the current part, click on the Current Part dialogue in the Display Options
dialogue.
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Or select PartsºCurrent on Menu bar

2. The Current Part dialogue window will be displayed.

3. Similar to the Part On/Off window,  this  window  allows  you  to  select  the  current  part  in
different ways. Place the cursor over each icon to identify its function.

4. Set the part BLANK.LI as current by selecting the part name from the Select by Name list
that is displayed.

5. Practice setting the current part.

6. Turn off all of the parts except BLANK.LI, and set it as current.
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MESHING

Meshing from surface or line data is a very important step contributing to a successful simulation.
There are many methods of creating mesh, however in this exercise, the Blank Generator and
Surface Mesh will be used to generate meshes.

I. BLANK MESHING

Blank meshing is the most important mesh function since the accuracy of the forming results
depends heavily upon the quality of blank mesh. There is a special function for blank meshing.

1. Select ToolsºBlank Generator on Menu bar.

2. There are four lines in BLANK.LI so select the BOUNDARY LINE from the Select Option
dialogue.

3. The Select Line dialogue window is shown as below.
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There are 4 lines in the part.  Select the lines, one-by-one by left clicking on them. This
Select  Line  dialogue  window  allows  you  to  select  the  line(s)  in  different  ways.  Place  the
cursor over each icon and button to identify its function.

4. Select OK after selecting all four lines.

5. Use the default variable (6.0) for the concerned tool radii.  This number reflects the tightest
radii in the model. The smaller the radii the finer the blank mesh; a larger value will result in
coarser mesh.

6. After you have entered the variable, press OK.  A Dynaform Question dialogue prompts
“Accept Mesh?”.

Press YES to accept the mesh.
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If you have entered an incorrect value, click on the ReMesh button to correct the concerned tool
radii value and accept the mesh, or No to cancel it and repeat the above steps to re-mesh.

7. Compare your mesh with the following picture.

8. Save the database.

II. MESHING SURFACE DATA

Most of the meshing done in eta/Dynaform is carried out using the Surface Mesh function. This
function will automatically create a mesh based on the provided surface data. This is a very quick
and easy way of meshing the tools.

1. Turn off the part BLANK.LI and turn on the part LOWTOOL. Set the part LOWTOOL as
current.

2. Select PreprocessºElements on Menu bar.
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3. Select Surface Mesh from the Element menu as shown below.

4. In the displayed Surface Mesh dialogue window, default values will be used for all fields.
Toggle off the in Original Part option, toggle off the Boundary Check option dialogue,

Note: Chordal deviation controls the number of elements along the line/surface curvature;
Angle controls the feature line,；
Gap Tol. Controls whether two adjacent surfaces are connected.
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5. Choose the Select Surfaces button from Surface Mesh dialogue.

6. From the Select Surface dialogue, choose the Displayed Surf icon

Notice  all  of  the  displayed  surfaces  will  turn  white.  This  verifies  they  have  been  selected.
This dialogue window allows you to select the surface(s) in different ways. Place the cursor
over each icon and button to identify its function.

7.  Click Apply button on the Surface Mesh dialogue.
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8. The mesh will be created and will be displayed in white. To accept the mesh, click the Yes
button when prompted, “Accept Mesh?” in the Surface Mesh dialogue. Check your mesh
with the mesh displayed below.

9. Press Exit on the Surface Mesh dialogue to exit the function.

Now that we have all the parts meshed, you can turn off the surfaces and lines by turning off
Surfaces and Lines in the Display Option dialogue. This makes it easier to view the mesh. Save
the changes.

10. Save the database.

III.MESH CHECKING

As the mesh has been created, its quality has to be checked to verify that there aren’t any defects
that could cause potential problems in the simulation.

All the utilities used for checking the mesh are located under the PreprocessºModel
Check/Repair on the Menu bar.
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As shown above, the Model Check /Repair dialogue consists of several functions that enable the
users to check the quality of mesh. Only two of the functions are described in this training
manual. Please refer to eta/DNAFORM online help for information regarding to the remaining
functions.
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Auto Plate Normal

1. Select Auto Plate Normal from the Model Check/Repair dialogue. A new dialogue will be
displayed.

2. The  displayed  dialogue  prompts  you  to  pick  an  element  to  check  all  the  active  parts  or  an
individual part for element normal consistency. Select an element on the part LOWTOOL.

3. An arrow will be displayed showing the normal direction of the selected element. A prompt
will ask “IS NORMAL DIRECTION ACCEPTABLE?” Click No reject that direction.

Pressing YES will check all elements in the part and reorient as needed to the direction that
is displayed. Pressing NO will  check all  elements and reorient as needed to the opposite of
the direction that is displayed. In other words, press YES if you want the normal to point in



eta/DYNAFORM  Training  Manual                                                              19

the direction of the displayed arrow, or NO if you want it to be the opposite. As long as the
normal direction of most elements in a part is consistent, program will accept that. If half of
the total element’s normal is pointing upper ward and other half pointing downward, program
will be confused how to constrain the blank through contact.

Note: In this case, we will offset upper tool from the lower tool by the normal direction. So select YES
to make sure the normal to point in the direction of the displayed arrow.

4. Now that the LOWTOOL elements are consistent, check the rest of the parts in the database.
Turn off all the parts and turn each one at a time. Check the normal direction and make sure it
is consistent.

5. Once all the normal directions are consistent, turn on all of the parts and save the changes.

Display Model Boundary

This function will check the mesh for any gaps or holes, and highlight them so you can manually
correct the problem.

1. Select Display Model Boundary from the Model Check dialogue window.

2. Minor gaps in the tool mesh are acceptable. Blank mesh should not contain any gaps unless
the  blank  is  lanced  or  is  designed  with  gaps.  Select  the  isometric  view  and  make  sure  that
your display looks like the following.
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3. Turn  off  all  of  the  elements  and  nodes  from  the Display Options dialogue (Note: the
boundary lines are still displayed). This allows you to inspect any small gaps that might be
difficult to see when the mesh is displayed. The results are shown in the following picture.
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4. Check for overlapping elements and minimum element size. Delete the duplicate elements if
there were found.

5. Turn only the part LOWTOOL on and click the Clear icon on the Toolbar to remove the
boundary lines.

6. Save your database.

IV. QUICKSETUP VS. TRADITIONAL SETUP

The analysis setup depending on whether the user is going to use QuickSetup or Tradtional setup.
Save the changes to your initial database and make a note of this file name. We will use this file
later in this training manual to perform a manual setup. Now use the Save As function to save
this as another duplicate database that we will use for the QuickSetup portion of this manual, for
example, dftraining_qs.df. The new database name and directory path should be displayed in the
upper right portion of the DYNAFORM interface.
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This manual will first detail the QuickSetup process, then the Traditional setup. Skip to the
Traditional Setup portion (page 67) of this manual if you are already familiar with the
QuickSetup interface and analysis setup procedure.
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QUICKSETUP

Before entering the QuickSetup interface we will need to separate the binder run-out (lower ring)
from the lower tool. This will allow the QuickSetup to automatically offset the upper binder from
this run-out. This procedure is common to all QuickSetup models that require a binder.

I. DEFINE THE LOWER RING FROM THE LOWER TOOL

Next step is to separate the Lower Ring from the LOWTOOL, and Move Elements on Run-out
of LOWTOOL into Lower Ring.

1. Turn on LOWTOOL and turn off all other parts.

2. Create a new part called LOWRING. This part will hold the elements that we separate from
the LOWTOOL. Click PartsºCreate on Menu bar.

3. Enter LOWRING in the name field. Click OK to create the part.
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4. The part LOWRING has been created and set as the current part automatically. We can now
place the lower ring elements in this part.

5. Click on PartsºAdd… To Part on Menu bar.

6. The Add…To Part window  appears  as  follows.  Click  the Element(s) button as shown
below.

7. The program displays the Select Elements window as shown in next page. The easiest way
to select all elements of the ring is to switch the view to the YX plane on the Tool Bar, then
select the Spread icon, press and drag the left mouse button on the Angle Slider  to  set  a
small angle. Since the Ring surface is flat, set the smallest angle you can select (e.g. 1 as one
degree).



eta/DYNAFORM  Training  Manual                                                              25

8. Click any element on the right-ring of LOWTOOL.
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All elements in the flat area before an element angle change of larger than 1 degree should be
highlighted. Compare your display to the preceding image. If your results differ, repeat the above
steps to re-select.

9. Click any element on the left-ring of LOWTOOL.

10. Select OK on the Select Elements window. You will find the number of elements (67) is
shown on the left side of the Element(s) button as below.

11. Select the Unspecified button.
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12. Dynaform displays the Select Part window. Select LOWRING in the Select by Name list.
The program changes the … button will change to LOWRING.

13. Click Apply, all selected elements are moved into LOWRING.

14. Turn on only LOWRING and  display  the  part  using  Top  view.  The  program  displays  the
result as the following. If the result differs, repeat the above steps.



eta/DYNAFORM  Training  Manual                                                              28

15. Save the changes.

II. QUICKSETUP INTERFACE:

1. Select the Setup menu, SetupºDraw Die.

2. As shown in the following QS menu, the undefined tools are highlighted in red. The user
needs to select the draw type and available tool first. In this application, the draw type is
“Single action” or Inverted draw. The available tool is the lower tool.
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3. Define the blank and tools by clicking the appropriate buttons.

III.DEFINE TOOLS

The parts LOWTOOL and LOWRING are meshed and can be defined as the Binder and Lower
Tool, respectively.

To define the Binder:

1. Click the Binder button, then select SELECT PART button from the DEFINE TOOL
dialog window.
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2. Add from the Define Binder window.

3. Select the part name from the part list: LOWRING.
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Repeat the same procedure to define the Lower Tool. Once both tools have been defined, the
color  in  the  Quick  Setup/Draw  window  will  be  changed  to  green  as  shown  in  the  following
picture.
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IV. DEFINING THE BLANK MATERIAL

1. Click the Blank button from QS GUI, and click “SELECT PART” from the Define Blank
dialogue.

2. Click “Add”, and pick the blank part name.

3. The user needs to define the material and thickness. For the blank thickness the user may
enter the number in the thickness field. In this case, we will use the default value of 1mm.

4. The blank material can be selected from the Material Library under the material definition
window.
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The Material Library will be shown as in the image below. Select the mild steel  “DQSK”
under material type 36(Note: material type 36 and 37 are recommended for most
simulations).

5. Select OK to use the default material parameters (following image) for the DQSK material
model (Note: ETA makes no guarantees as to the validity or accuracy of the generic material
models in the material library. Users should contact their material suppliers to determine
material parameters). To complete the material definition, select OK from the material
dialogue and return to the QuickSetup interface. Save the changes.
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The following are the description of other functions in the QS interface:

· Auto Assign will assign parts as tooling that follow the QuickSetup default naming
convention; for example, if the blank part name is named “BLANK”, once the auto
assign button is selected, the part “BLANK” will be defined as the model BLANK.
“DIE” and “BINDER” are the other tooling names recognized and automatically
assigned. Drawbeads are not recognized by the Auto Assign function.

· Constraint allows the user to define SPC (single point constraint) for symmetric or
other boundary conditions.

· Advanced allows the user to change default parameters related to QuickSetup.
· Apply automatically offsets all defined tooling with its mating tool and defines the

travel curves.
· Reset deletes all mating tools and travel curves “resetting” the database to the state it

was before the apply button was selected.
· Preview allows the user to animate and check the tooling travel curves.
· Submit job brings the user to the analysis menu.
· Exit will allow the user to exit the QS menu.
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6. Now back to our exercise: Select Apply; the program will automatically create mating tools,
position the tools and generate the corresponding travel curves.

7. Select Preview to check the tooling motion.

8. Compare your display with the illustration as shown below.
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V. RUNNING THE ANALYSIS

After  verifying  the  tool  motion  is  correct,  we  can  define  the  final  parameters  and  run  the
analysis.

1. Click Submit Job button to display the “Analysis” dialogue window shown on next page.



eta/DYNAFORM  Training  Manual                                                              37

2. Click the Control Parameters button in the Analysis dialogue.
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As  a  new  user,  it  is  recommended  that  you  use  the  default  control  parameters  (for  more
information on them, please refer to the LS-DYNA User’s Manual). Click OK.

4. By default,  the Adaptive Mesh option is checked. Adaptive mesh allows for more accurate
results by re-meshing the blank as needed. In other words, as the die deforms the blank, areas
that demand a finer mesh to capture the tooling geometry will divide to create finer and
smaller elements.

5. Click Adaptive Parameters to display the ADAPTIVE CONTROL PARAMET dialogue
window.  Set the LEVEL (MAXLVL) to be 3. This means that the mesh will split up to 2
times if needed. Higher levels of adaptivity will result in better accuracy but require longer
processing time. Since this is a simple part, level 3 will be sufficient. The default values will
be used for other parameters. Click OK.

6. To submit the job, select Full Run Dyna. Toggle on “Specify Memory” check box and key
in 120 (Mb).  Then,  click OK to run the job. The solver will now be running in the
background.
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The  solver  displays  a  DOS  window  showing  the  status  of  the  job.  You  will  notice  that  an
estimated completion time is given. This time is not accurate since we are using adaptive mesh
and the model will re-mesh several times. Also, the number and speed of CPU influence it.
However, it does give you a general idea.

Proceed to page 97 for post-processing after the program is completed.
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3. Once the solver has given you the preliminary estimated time, you can refresh this estimate
by pressing Ctrl-C. This will momentarily pause the solver which will prompt you to “.enter
sense switch:”. Type the switch command you would like to use and press enter:

sw1 – Terminates the Solver

sw2 – Refreshes the Estimated Solving Time

sw3 – Creates a d3dump Restart File

sw4 – Creates a d3plot File

Note: These switches are case sensitive and must be all lower case when entered.

Enter sw2 and press Enter. Notice the estimated time has changed. You can use these
switches at anytime while the solver is running.
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When you submit a job from eta/DYNAFORM, an input deck is created which the solver,
LS-DYNA,  uses  to  process  the  analysis.  The  default  input  deck  names  are
yourdatabasename.dyn and yourdatabasename.mod. The .dyn file contains all of the control
cards, and the .mod file contains the geometry data. Advanced users are encouraged to study
the .dyn input file. For more information, refer to the LS-DYNA User’s Manual.

Again, the eta/DYNAFORM Quick Setup interface is designed to help the user to quickly setup a
standard draw simulation. The user is encouraged to learn the traditional, a more flexible way of
setting up a draw simulation (Traditional Setup).  Following the traditional setup procedure is a
section on post processing the results, which is applicable to both types of setup.
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AUTO SETUP

Open the saved database as described in meshing section of this manual (on page 22)
dftraining_as.df.  This file should contain the clean mesh data of the LOWTOOL layer . If you
do not have this database, repeat the procedure of MESHING.

Before entering AUTOSETUP interface, we only need mesh tools. The other operation can be
finished in auto setup interface, such as PHYSICAL OFFSET of  element,  selection  of
CONTACT OFFSET. The user can click AUTOSETUP option located at the blow of SETUP
menu to display the interface.

I. NEW SIMULATION
Click AutoSetup in the menu bar, then the program will pop up auto setup interface and
prompt the user to define basic parameters.

1． Select simulation type: Sheet Forming .

2． Select process type: Single Action.
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3． Input blank thickness:1.0.

4． Select tools reference: Punch.

5． Click OK to display the main AUTOSETUP dialogue box.

a) Using DIE geometry as reference for contact offset

b) Using PUNCH geometry as reference for contact offset

c) Using both DIE & PUNCH physical geometry
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II. GENERAL
After entering General interface, the user needn’t modify any parameters, and only change
Title into Df_training_01.

III.BLANK DEFINITION

1．Enter Blank interface , and click the red Blank tag, then the program will display Blank
Definition interface.

2．Click Define geometry… button from Geometry in blank definition interface.
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3.  The program will pop up the dialogue box of blank definition.

4.   Click Add Part… button, the user can select BLANK layer in the dialogue box.
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5.  After selecting the layer, we exit the part layer. The program returns the dialog box of
the blank definition. We can see that the BLANK layer has been added to the list of the
BLANK layer.

6. Exit the dialogue box of the blank layer definition, and then return the blank definition
interface. Now the parameters have been defined about the blank, and the tag color of the



eta/DYNAFORM  Training  Manual                                                              47

Blank is changed red into black.

IV. TOOLS DEFINITION

1. Enter Tools interface , and click the red Tools tag, then the program will display Tool
Definition interface.

2. Click  button in the Toolbar, and turn off the BLANK layer.  Then  exit  the  part
layer .

3. The program defines three default tools : die, punch and binder located at the left of
tools interface. The user can define the tools one by one.

4. Enter die interface, and select die located at the left of tools list, then select Define
geometry… button to define die.
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5. The program pops up tool geometry define dialogue box. We click Add Part… button
in the dialogue box.

6. Select LOWTOOL layer in the pop-up part selection dialogue box.
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7. Click OK and return tool geometry define dialogue box. The LOWTOOL layer has

been added to the list of die.
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8.   Click EXIT and return Tool Definition interface. Now die has  been  defined.  The  tag
color of Die is changed red into black.

9.    Click punch located at the left of tools list to display punch definition interface .

10.   Click Define geometry… button in the punch interface. The program pops up tool
geometry define dialogue box.

11.   Click Copy Elem… button in the tool geometry define dialogue box.

12.  The program pops up Copy Element dialogue box. The user need click Select… button,
and select copied element.
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13.  Select some elements that define punch from  the  current  database.  Then  the  program
will copy these elements into a default part layer, and automatically add the layer to the list of
punch.
14.  Click DISPLAYED button to select all elements in the pop-up Select Elements
dialogue box. Now the program prompts that 779 elements have been selected.

15.  Then remove elements on the flanges of a part. We can toggle on EXCLUDE option,
and select elements by way of selecting surface in the Select Elements dialogue box.
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16.   Select  two sides  of  the  flanges  by  way of  selecting  surface,  now remove elements  of
flanges. See figure,  the black part shows these elements have been selected.
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17.  Now the program will prompt the user to toggle on 721 elements.
18.   Click OK and exit the Select Elements dialogue box. The program returns Copy Elements
dialogue box. Now APPLY button is activated.

19.   Click Apply button, now the selected elements will be copied to a new part layer.

20.   Click Exit button in the Copy Elements dialogue  box.  Now  a  new  part  layer  named
OFFSETOO is added to the list of tools geometry.
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21.   Click Exit button and return the main Tools Definition interface. Now the tag color of
punch is changed red into black. Punch has been defined.

22.   Click binder located at the left of tools interface, and enter binder definition. Click
Define geometry… button .

23.   Click Copy Elem… button, and click Select… button to select some elements that need
to be copy to Binder.

24.  Select the flange in the two sides of tool by way of selecting surface. The program will
prompt 72 elements have been selected.
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25. Exit the Select Elements dialogue box. Click Apply button to copy elements in the
Copy Elements dialogue box. All selected elements will be automatically copied to a
new part layer, and the program will add the part layer to the list of Binder. Then click
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Exit button.

26.   Click Exit to return the main Tools Definition interface. The tag color of all tools has
been changed red into black.  It mains that all tools have been defined .

V. TOOL POSITIONING

After  defining  all  tools,  the  user  need  position  the  relative  position  of  tools  during  die  sinking.
This step must be operated every time, otherwise, the user can not obtain correct result.
Furthermore, Tool Position is related to the working direction of every tool. So we need check
carefully the working direction of every tool before we position tools. Under default condition, if
the user applies the process template that the program has set, the default working direction need
not be modified. To special direction, the user need adjust it .

1. Click Positioning… button located at the right of tools interface to display the
Tools Position dialogue box, or click Tools->Positioning… on the menu bar.
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2. Select 10_punch near Fixed option and use punch as the referenced tool, which
means the tool is stationary during automatic positioning.

3. Then clicks Auto button to position all tools and blanks automatically.
4. Now all tools and blank(s) will move to a suited location. The value behind every

tools is the distance from the home position to the current position.
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5. We  remove  the  display  of Lines and Surfaces in Display Options located at the
right of screen.

6. Click  and  on the Toolbar, and the relative position of tools and
blanks during die sinking will be displayed on the screen.
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7. The user clicks OK to save the current position of tools, and then returns the main
interface.

Now, all Tools have been positioned. The user can set up next process. During the new
automatic setup , the order of definition of the Blank, Tools and Process is discretional. But
an experiential engineer should have a good habit, so we suggest that the user should set up
the tools and blanks step by step.

VI. PROCESS DEFINITION

Process definition is helpful to setting up process numbers , time of every process, condition of
every tool and so on. The user can click Process of the main interface, and enter process
interface. When defining a new setting, the user only need select a template. Then the program
will automatically add some essential processes. To typical program, these processes need not
amend or amend a little. In this way, the user can reduce setting time.
We select the Single Action template before, so the forming brings two default processes, one
is  binder  process,  and  the  other  is  draw  process.  When  two  processes  have  been  defined,  the
user need not modify any parameters. Entering next step, the user only need check whether the
result of setting looks the same as the illustration shown blow.

1.  Select closing process from the list located at the left of interface to be the current
process.

2.  We should check whether default closing accords  with  the  below figure.  Under  default
condition, they is uniform.
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3.  Select drawing process from the list located at the left of interface to be the current
process.

4.  We should check whether default drawing accords with the below figure. Under default
condition, they is uniform.
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VII. ANIMATION

Now, all setting have been finished . The user can submit job. But before submitting job, the user
had better to display model setting by animation in order to check the movement condition of the
tools.

1.  Select Preview->Animation… in the menu bar.
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2.  Now the tools display movement condition by animation.

3.  The user can click INDIVIDUAL FRAMES to display single movement condition.

4.   Click  to display the condition step by step.

5.  The program will prompt user the current positions of all tools relative to their original
locations on the screen.

6.   Click Exit to return the main interface.
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VIII. SUBMIT JOB

After validating the correctness of tools movement, we can submit job.

1.   Click Job->Job Submitter… in the menu bar.

2.  The program pops up Submit Job dialogue box.

3.   Click Submit button to submit job.
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4.   Click Submit Jobs button to calculate.
Now the current job will be submitted to uniform management. If Job Submit has been
running some jobs, the current job need wait. Otherwise, the program will pop up LS-DYNA
window to run it.
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TRADITIONAL SETUP

Open the saved database as described in meshing section of this manual (on page 22).  This file
should contain the clean mesh data of the lower tool before it was separated for the QuickSetup
procedure. If you do not have this database, repeat the procedure of MESHING.

I. OFFSETTING THE LOWER TOOL MESH TO CREATE THE UPPER
TOOL

1. Create a new part called UPTOOL. This part will hold the elements that we offset from the
LOWTOOL. Click PartsºCreate on Menu bar.

2. In the New Part dialogue, enter “UPTOOL” in the name field. Click OK and the part will
be created.

The part UPTOOL has been created and set as the current part automatically. We can now
offset elements into this part. Turn on LOWTOOL and turn off BLANK.LI.

3. Select PreprocessºElements on the Menu bar.

4.  Select the Offset icon from the Elements dialogue.
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5. Toggle off In Original Part so that the offset elements will be put in the current part. Make
sure UPTOOL is set as current. Toggle off Delete Original Part, the original part will be
kept.

6. Enter 1 in  the  field  where  it  says Copy Number, as  the  number  of  copies.  Enter 1.1 in the
field where it says Thick, as the offset thickness. In eta/DYNAFORM, the offset thickness is
based  on  the  material  thickness  of  the  blank  plus  10%  tolerance.  Since  we  will  be  using  a
blank thickness of 1, enter 1.1 in the field.

Note: We use 10% of the thickness for simulation because when we do the post-processing, wrinkle data
can be lost if there is not enough space between the punch and die after it has completed its travel
path. If we use only the blank thickness as a gap, the punch will iron the blank flat, creating the
impression that no wrinkling has occurred.

7. Click Select Element button.

8. Select Elements dialogue appears. Click the Displayed button, you will notice that the
selected elements will turn white.
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9. Click OK to accept the selected elements and return to the Copy Elements dialogue.

10. Click on Apply, all offset elements are placed into the part UPTOOL. Check your display by
clicking the Left View icon.
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11. If your results differ, select Undo. Repeat the above steps to create mesh of UPTOOL.

12. Turn off the part LOWTOOL so that only UPTOOL is displayed. Switch to the isometric
view.

13. Save the changes.

II. CREATE THE LOWER RING

Now we will separate the Lower Ring from the LOWTOOL and Move Elements on Run-out of
LOWTOOL into Lower Ring.

1. Turn on LOWTOOL and turn off all other parts.

2. Create a new part called LOWRING. This part will hold the elements that we separate from
the LOWTOOL. Click PartsºCreate on Menu bar.

3. Enter LOWRING in the name field. Click OK and the part will be created.
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4. The part LOWRING has been created and set as the current part automatically. We can now
place the lower ring elements in this part.

5. Click on Parts º Add…To Part from Menu bar.

6. The Add…To Part window  appears  as  follows.  Click  the Element(s) button as shown
below.
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7. The Select Elements window  appears  (as  shown  above).  The  easiest  way  to  select  all
elements  of  the  ring  is  to  switch  the  view  to  the Top View (YX plane). Then, select the
Spread icon. Click the slider and drag it to set an angle. Since the ring surface is flat, set a
small angle, such as 1 degree.

8. Click any element on the right ring of LOWTOOL.

9. Click any element on the left-ring of LOWTOOL.

All elements in the flat area before an element angle change of larger than 1 degree should
be highlighted. Compare your display to the preceding image. If your results differ, repeat
the above steps.

10. Select OK on the Select Elements window. You will find the number of elements (67) is
shown on the left side of the Element(s) button as below.

11. Select the … button.
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12. The Select Part window shows up. Select LOWRING in the Select by Name list. At this
time, the … button will change to LOWRING.

13. Click Apply, all selected elements are moved into LOWRING.

14. Turn on only LOWRING and display the part using Isometric view, the resulting display
should be as the following. If the result differs, please repeat the above steps.
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15. Save the database

III.SEPARATE LOWRING AND LOWTOOL

Now LOWRING and LOWTOOL have two different groups of elements but they share
common nodes along the boundaries. We need to separate them so that LOWRING and
LOWTOOL can move independently.

 Let’s turn on LOWRING and LOWTOOL and turn off other parts.

1. Click PartsºSeparate on the Menu bar.

2. The Select Part window appears. Select LOWTOOL and LOWRING in the Select by
Name list. Click OK to finish the function.

3. Save the changes.
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IV. DRAW TYPE SETUP

Prior to defining the tools, we first setup the draw type.

Click ToolsºAnalysis Setup from Menu bar. Select the Single Action as the Draw Type.

The Draw Type should correspond to the type of machine used to produce the actual work piece.
This parameter defines the default moving direction of the punch and binders. If you are not sure,
or are performing a new process, you should select User Defined. You can also refer to the
eta/DYNAFORM User’s Manual for information on the draw type.

V. TOOL DEFINITION

Defining Parts as Tools

The parts BLANK.LI, LOWTOOL, UPTOOL, and LOWRING are all meshed and can now
be defined as tools.

1. Select ToolsºDefine Tools on Menu bar.
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2. In the Define Tools dialogue, select DIE from the Tool Name menu as below.

3. Select ADD.

4. The Select Part dialogue will be displayed, prompting you to select which part will be
defined as the DIE. Choose UPTOOL from the Select by Name list and then click OK.

5. Return to the Define Tools dialogue. You will find the UPTOOL is placed in the Include
Parts List.
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6. Repeat the above steps to define the Punch (LOWTOOL)  and  Binder  (LOWRING).
Remember to select the correct Tool Name in Step 2.

7. Once you have all of the tools defined, click OK on the bottom of Define Tools dialogue to
finish this step. Save the changes.
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VI. DEFINING THE BLANK AND SETTING UP PROCESSING
PARAMETERS

Define the Blank

1. Select ToolsºDefine Blank on the Menu bar.

2. Click the Add button in the Define Blank dialogue.

3. The Select Parts dialogue is displayed. Select BLANK.LI from the Select by Name list.

4. Click OK. The BLANK.LI is added to the Include Part List as shown below.

Define the Blank Material

1. The Define Blank dialogue should still be opened, click the button located right next to
“material:”
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2. Select Material Library. A list of materials will be shown as in the illustration below. In this
dialogue, select the mild steel “DQSK” under material type 36 (Note: material type 36 and
37 are recommended for most simulations).
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3. Select OK to use the default material parameters (following image) for the DQSK material
model (Note: ETA makes no guarantees as to the validity and/or accuracy of the generic
material models from the material library. Users should contact their material suppliers to
determine proper material parameters).

Define Blank Property

1. The Define Blank dialogue should still be open, click the button just right of where it says
Property: (This button will say None because the property has not been defined yet).
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2. In the Property dialogue, enter a name for the material, For example put “blankpro” for
material  property.  (If  there  is  a  default  property  name  exists,  user  can  skip  the  typing).  Be
sure to select type BELYTSCHKO-TSAY (default)  and  select  any  color  from Color
dialogue. Click New.

3. The BELYTSCHKO-TSAY Property card will be displayed. In this dialogue, you can edit
the thickness of the material. To edit a field, left click on the field and change the value in the
Current Value dialogue. Make sure UNIFORM THICKNESS is 1.000. Leave all other
fields at their default values and select OK.

4. eta/DYNAFORM returns to the Property dialogue. Click OK.

5. Select OK to finish defining the Blank, Material and Property.
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VII. TOOLS SUMMARY

1. Verify that all of the needed tools are defined by selecting the Tools Summary function in
the Tools menu.

2. After you have verified the tooling definition, click OK. Save the changes.
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VIII. AUTO POSITIONING THE TOOLS

Now  that  all  of  the  tools  have  been  defined,  we  need  to  place  them  in  the  correct  position  by
doing the following:

1. Turn on all of the parts in the database and select the isometric view.

2. Click ToolsºPosition ToolsºAuto Position on the Menu bar.

3. The Auto Position Tools dialogue will be displayed. In this dialogue, define the Master and
Slave Tools. The Master Tool is the tool that will not move while you Auto Position; it should
be the Blank. Select BLANK in the Select Master Tool dialogue  and  then  select  the
remaining tools in the Select Slave Tools dialogue.  (For  the  PC  version,  the  user  needs  to
hold down the control key to select all three slave tools).
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Once the correct Master and Slave Tools are selected, be sure that Z (direction) is selected as the
moving direction and enter a Contact Gap of 1.  The gap value should be the Blank Thickness
to avoid initial penetration. Press Apply and the tools will be automatically positioned.

4. Compare your display with the following image.
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5. If your result differs, select UNDO to repeat the above steps and make sure the result is
correct. If the position is wrong, check Tools/Analysis Setup, make sure the “Draw type” is
set to inverted.

6. Select CLOSE to exit the auto position menu.

7. Save the changes.

IX. MEASURING THE DIE TRAVEL DISTANCE

Now that the parts have been meshed and defined as tools, we can setup the motion curves. The
first step is to find the travel distance of the tools.

1. Click ToolsºPosition ToolsºMin Distance on Menu bar.
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2. The Min. Distance dialogue will be displayed. Select Z (direction)  as  the  direction  to
measure in, then highlight the DIE, following by the PUNCH. This will allow user to
measure the distance, in the Z-direction, between the Punch and the Die, and display it in the
Distance dialogue.
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3. The  total  distance  between  the  Punch  and  the  Die  is  approximately  42.  To  find  the  Punch
travel distance, subtract the offset thickness (blank thickness + 10%). We will obtain a Punch
travel distance of approximately 40.9. Take note of the number you calculated.

4. Select OK located at the bottom of the Min. Distance dialogue, and end this step.

The automatic distance measurement is reliable for flat binders. For more complicated binder
shapes, the user should measure the travel distance using the distance measurement tool between
nodes found under the Utilities menu.

X. DEFINE DIE VELOCITY CURVE

1. Click ToolsºDefine Tools on the Menu bar.

2. Select Die from the Tool Name list and then select the Define Load Curve button.
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3. Click on Auto. Make sure the Z is selected as the Degrees-of-Freedom to define the moving
direction. Use the default curve type (Motion) (see the following illustration).

4. Choose Velocity as the default Curve Type (see illustration below) and default Curve Shape
as Trapezoidal. Keep the beginning time of 0.000E+000. In the Velocity field, enter 8000
(mm/s). For the Stroke Dist., use the value that we found after measuring the Punch travel
distance and subtracting the Blank thickness. The value should be approximately 40.9. After
entering the values, click Yes and a new Velocity vs.  Distance motion curve will  be created
and displayed (as shown in the following illustration).

Toggle the Z
button on to
free the Z
direction travel
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5. Verify that the load curve is identical to the graph as shown on next page.
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6. Select Ok in the Curves dialogue  to  return  to  the Tool Load Curve dialogue.  From  here,
click Ok once more to return to the Define Tools dialogue. Do not close this dialogue, the
next step will start from here.

XI. DEFINING THE BINDER (LOWRING) FORCE CURVE

As the Punch travel curve has been created, we can create the force curve for the Lower Ring.

1. From the Define Tools dialogue, select Binder from  the Tool Name menu and select the
Define Load Curve button.
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2. Select Curve Type (Force). Make sure to select Z to define the moving direction and then
click Auto button.

3. Enter 200000 (N) in the FORCE and close the window by clicking OK.

4. The Lower Ring force curve will be displayed. Verify that it is identical to the curve shown
on next page.

5. Select OK in the Curves dialogue to return to the Tool Load Curve dialogue. From here,
select OK once more to return to the Define Tools dialogue.
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6. Click OK in the Define Tools dialogue; we are done defining the motion curves for the tools.

7. Save the changes.

XII. PREVIEW TOOL ANIMATION

We have now completed all of the pre-processing outside of setting up the final simulation
parameters and submitting the job. Before we can do that however, we should verify that the
tools are moving correctly, based on the motion curve information we have assigned.

1. Click ToolsºAnimate on Menu bar.

2. Click Play to animate the tooling using the default parameters.

Note: Depending on the speed of the machine that is used to run eta/DYNAFORM, the animation
might move too quickly. If this is the case, enter a larger number of frames.

3. You can change the view while running the preview animation. Verify that the Punch is
moving in the Z-direction, and make sure it is moving the full distance into the Die. Since we
are using a force curve for the Binder, you will not see it move. Also, notice the Individual
Frames switch  on  the  dialogue.  After  viewing  the  animation,  click  the Stop button on the
Animate dialogue to exit the function.



eta/DYNAFORM  Training  Manual                                                              91

4. Save the database.

XIII. RUNNING THE ANALYSIS

After  verifying  that  the  tool  motion  is  correct,  we  can  define  the  final  parameters  and  run  the
analysis.

Running the Analysis with Adaptive Mesh

Adaptive mesh allows the user to obtain more accurate results by refining the blank mesh as
needed during the simulation. In other words, as the die deforms the blank, areas that demand a
finer mesh to capture the tooling geometry will divide to create finer and smaller elements.

1. Select AnalysisºLS-DYNA… from the Menu Bar.

2. Click the Control Parameters button in the Analysis Parameters dialogue.

3. As a new user, it is recommended to use the default control parameters (for more information
on them, please refer to the LS-DYNA User’s Manual). Click OK.
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4. There are two methods to run the job.

1. Select Full Run Dyna and press OK. The solver will now be running in the background.

2. For manual submission of the input deck:
a.  Select LS-Dyna Input File and enter a file name (e.g. training) and press Ok.

b. Find the directory that includes your current example file (training.df), you will find
two files “training.dyn” and “training.mod”. All files generated by either
eta/DYNAFORM  or  LS-DYNA  will  be  placed  in  the  directory  in  which  the
eta/DYNAFORM database has been saved. This includes all input decks and post
processing files.

c. Then select File->Submit Dyna from Input Deck, find the “training.dyn”, then press
OK.

d. Give a right memory, press OK to start the solver.

The  solver  displays  a  DOS  window  showing  the  status  of  the  job.  You  will  notice  that  an
estimated completion time is given. This time is not accurate since we are using adaptive mesh
and the model will re-mesh several times. Also, it is influenced the speed and number of CPU of
the machine. However, it does give you a general idea.

5. Once the solver has given you the preliminary estimated time, you can refresh this estimate
by pressing Ctrl-C. This will momentarily pause the solver which will prompt you to “.enter
sense switch:”. Type the switch command you would like to use and press enter:

sw1 – Terminates the Solver

sw2 – Refreshes the Estimated Solving Time

sw3 – Creates a d3dump Restart File

sw4 – Creates a d3plot File
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Note: These switches are case sensitive and must be all lower case when entered.

Enter sw2 and press Enter. Notice the estimated time has changed. You can use these
switches at anytime while the solver is running.

When you submit a job from eta/DYNAFORM, an input deck is created which the solver,
LS-DYNA, uses to process the analysis. The default input deck names are yourdatabase
name.dyn and yourdatabasename.mod. The .dyn file contains all of the control cards, and
the .mod file contains the geometry data. Advanced users are encouraged to study the .dyn input
file. For more information, refer to the LS-DYNA User’s Manual).

Note: All files generated by either eta/DYNAFORM or LS-DYNA will be placed in the
directory in which the eta/DYNAFORM database has been saved. It is necessary to make
sure the fold doesn’t include other resultant files before running the current job in case part
of files are overwritten.
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POST PROCESSING (with eta/POST)

The eta/POST reads and processes all the available data in the d3plot file.  In  addition  to  the
undeformed model data, the d3plot file also contains all result data generated by LS-DYNA
(stress, strain, time history data, deformation, etc.).

I. READING THE RESULTS FILE INTO THE POST PROCESSOR

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar. The default path for
eta/POST is C:\Program Files\Dynaform 5.6. In this directory, double click the executable file,
EtaPostProcessor.exe. The eta/POST can also be accessed from the programs listing under the
start menu under DYNAFORM 5.6.

The eta/DYNAFORM Menu Bar

The eta/POST GUI
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1. From the File menu of eta/POST, select Open. The Open File dialogue will be displayed.

2. Select LS-DYNA Post (d3plot, d3drlf, dynain) from the Files of Type list. This option will
allow you to  read  in  the d3plot, d3drlf or dynain file. The d3plot is output from forming
simulation (drawing, binder wrap and springback), while d3drlf is generated during gravity
loading  simulation,  the dynain is  generated  at  the  end  of  simulation  and  put  the  deformed
blank information.

After moving to the directory where you saved the result files, be sure you have the correct
file of type selected, pick the d3plot file, and press Open.

3. The d3plot file is now completely read in. You are ready to process the results using the
result manipulation menu bar as shown below.
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II. ANIMATING DEFORMATION

1. The default Plot State is Deformation. In the Frame dialogue, select All Frames and then
press Play button to animate the results.

2. Toggle on the Shade check box near the bottom right of the screen to shade the model. The
user can toggle on Smooth Shade to display a smooth model.

3. Since it is difficult to see the Blank with all of the other tools displayed, you can turn them all
off, except for the Blank. From Toolbar menu, select Part on/off button.
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4. In Part Operation dialogue, turn off all of the parts except for the Blank and press Exit.

5. You can also change the view with the view manipulation icons on the tool bar, just as we did
in the pre-processor.

III.ANIMATING DEFORMATION, THICKNESS AND FLD

eta/POST can animate deformation, thickness, FLD and various strain/stress distribution of the
blank. To do this, refer to the following examples.
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Deformation

The deformation in result manipulation menu bar is set as the default display.

1. Select All Frames from the combo box (drop down menu). All the frames are highlighted.
2. Click Play button to display animation of deformation.
3. Use the slider to set the desired frame speed.
4. Click Stop button.

Thickness/Thinning

1. Select Thickness from the result manipulation menu bar.
2. Select Current Component from combo box, either THICKNESS or THINNING
3. Click Play button and the animation will begin.
4. Use the slider to set the desired frame speed.
5. Click Stop button to stop the animation.
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FLD

1. Pick FLD from the result manipulation menu bar.
2. Select Middle from the Current Component list.
3. Set FLD parameters (n, t, r, etc.) from FLD Curve Option.
4. Select Edit FLD Window to define location of FLD plot on the display window.
5. Click Play button and the animation will begin.
6. Click Stop button.
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IV. PLOTTING SINGLE FRAMES

Sometimes, it is more convenient to view single frames rather than the entire animation. To do
this, select Single Frame from the Frame combo box. Then, select with your mouse, the frame
you would like to view from the frame list. Users can also drag the slider of frame number to
select the frame accordingly.
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V. WRITING AN AVI AND E3D FILE

eta/POST has a very useful tool that allows the user to automatically create an AVI movie and
E3D files via an animation screen capture. This will be the last function covered in this training
case.

AVI movie
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1. Start a new animation using all available steps.

2. Once the animation is running, click the Record button located at the dialogue.

3. The Select File dialogue will be displayed. Enter a name to save the AVI file under (e.g.
traincase.avi), and click Save.

4. Select Microsoft Video 1 from the Compressor list and click Ok.

5. eta/POST will take a screen capture of the animation and write the output.
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E3D file

eta/POST allows the user to save simulation results in a much compact file format (*.e3d). The
*.e3d file can be viewed using eta/3DPlayer which is provided free to any users. The users can
view  3D  simulation  results  using  the  player.  To  start  the  player,  select  StartàAll
ProgramsàDynaform 5.6àEta3DPlayer.



eta/DYNAFORM  Training  Manual                                                              104

MORE ABOUT DYNAFORM 5.6

Inside the DYNAFORM 5.6 installation directory, there is a file called .DyanformDefault.
Many key default parameters are included in this file. Advanced users can change these default
parameters to customize the program.

For Unix/Linux users, the .DynaformDefault file is located under both the installation directory
and the user’s home directory.  The .DynaformDefault file located under the installation
directory will take precedence over the one located in the user home directory.
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CONCLUSION

This concludes the training guide’s basic overview of eta/DYNAFORM 5.6. This manual is
meant to give the user a basic understanding of finite element modeling for forming analysis, as
well as displaying the forming results. It is by no means an exhaustive study of the simulation
techniques and capabilities of DYNAFORM. For more detailed study of DYNAFORM, the user
is urged to attend a DYNAFORM training seminar.

Please refer to the DYNAFORM and the LS-DYNA User’s Manuals for detailed explanation of
individual functions and analysis settings.

eta/DYNAFORM team
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